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Section A: (Objective Type Questions)
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Section B: (Subjective Type Questions)
Anchoring refers to the reference point for the graphics.
Under the Format menu, Alignment, Arrange, Wrap feature of an image can be accessed.

The To Foreground option moves the drawing object in front of the text. While, the To
Background option moves the drawing object behind the text

The buttons used in Table of Content are:

« The N# button inserts the heading number or list number of the entry.

« The E button represents the entry text.

e The T button represents a tab stop.

e The # button represents the page number.

Four effects of Filter tool are as follows:

« Smooth: It softens the contrast of the image.

« Sharpen: It increases the contrast of the image.

« Remove Noise: It removes single pixels from the image.

« Aging: It brings the impact of time with the age.

Cropping an image

It involves removing unwanted portions of the image to focus on a specific area or to
improve its composition. It is equivalent to using a scissor to cut the unwanted part.

Resize an Image

Sometimes an image size is required to be altered in a document either by increasing its
size or by decreasing its size. Resizing is the process of reducing or enlarging the size of
the image. The resizing of a picture will alter the resolution of a picture.

To crop an image, perform the following steps:
Step 1:  Select the image in the Writer document.
Step 2:  Click on the Crop Image tool from the Image toolbar.

Notice that, the eight little squares surrounding the image will be transformed
into blue handles.

Step 3:  Click and drag the handles on the image to adjust the crop region as desired.
You can crop from any side or corner.

The image is cropped.

Grouping of the drawing objects is the process of combining two or more objects to behave
as one object. It becomes easier to move, cut, or copy the grouped objects. The number
of objects grouped can easily be ungrouped.

The steps to group the objects are as follows:

Step 1:  Select multiple objects by using mouse click and holding the Shift key.
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Step 2:

Click on the Format — Group option and then select the Group option from
the sub menu.

OR

Right-click on the selected objects and then select the Group option from the
context menu.

OR
Select the Group option from the Drawing Object Properties toolbar.

The selected objects get grouped into one object.

Text Wrapping allows the placement of image in relation to text. Text Wrapping tools are
available under Drawing Object Properties toolbar. Text wrapping is essential for integrating
graphics seamlessly into the text flow of a document.

Different options to wrap text are as follows:

« None: The text is placed above and below the image.

- Before: The text is placed before the image.

+ After: The text is placed after the image.

« Parallel: Text flows around the image. Moving an image will rearrange the text on the

page.

» Through: The image comes above the text. In this case the image should have
transparency so that the text below it is visible properly.

« Optimal: Optimal prevents text from being placed to the side of the image if the spacing
between the image and the margin is less than 2 cm.

After reviewers have made changes and provided comments, LibreOffice Writer enables
you to compare the original document with the reviewed version. You can then select the
option(s) that best suit your needs.

To compare the document, perform the following steps:

Step 1:
Step 2:

Step 3:

Step 4:
Step 5:
Step 6:

Open the reviewed document.
Select the Edit Track Changes Compare Documents option from the Menu bar.
OR

Click the Compare Non-Track Changed Document button in the Track Changes
toolbar.

The Compare to Original Document dialog box opens.

Browse and select the original file to be compared.

The Manage Changes dialog box is displayed.

Accept or reject the desired changes by clicking the respective buttons.
Click the Close button to close the dialog box when done.

Save the edited file.
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Shinjini can use the following important features in LibreOffice Writer to design an invitation
card for her parents’ 25th wedding anniversary:

« Set the page size and orientation to “Portrait” or “Landscape,” depending on the card
design.

« Apply proper style to text and paragraph.

« Add borders around the card or specific sections to create a framed look and apply
shading or background colours to make the card visually appealing.

« Insert images like a photo of her parents, decorative elements, or anniversary-themed
icons (e.g., hearts, rings, champagne glasses). Also, use clipart or download suitable
images and icons to enhance the card.

« Use shapes (e.g., rectangles, ovals) to create custom sections or highlight specific parts.

« Use text boxes to place text in specific areas of the card. Also, utilize text wrapping
around images or shapes for better layout management.

« Check the invitation card in "Print Preview” mode to ensure all elements are correctly
aligned and appear as intended.

By using these features, Shinjini can create a beautiful and personalized invitation card for
her parents’ special occasion in LibreOffice Writer.

Advika can use several methods to add images to her document:
» Inserting an image using Insert menu
 Inserting an image using Drag and Drop method
« Inserting an image using Copy and Paste option
Using Insert Menu
To insert image using Insert menu, follow the given steps:
Step 1:  Open the document in which you wish to insert an image.
Step 2:  Click on Insert menu and select the Image option.
The Insert Image dialog box opens.

Step 3:  Select a specific folder and subfolder and click on the image file that you wish to
insert.

Step 4:  Click on Open button.

The image will be inserted at the desired position.
Using Drag and Drop Method
To insert image using drag and drop method, follow the given steps:
Step 1:  Open the document in which you wish to insert an image.
Step 2:  Open File Explorer and locate the image you want to insert.

Step 3:  Select the file and drag it into the desired place in a document.
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Step 4:

After reaching the desired place, release the left mouse button.

You will see the image inserted into that selected place in the document.

Using Copy and Paste Option (Using Clipboard)

To insert image using copy-paste option, follow the given steps:

Step 1:
OR
Step 2:
Step 3:
Step 4:
a.
Step 1:
Step 2:

Open the document and select the picture which you wish to copy.

Select the image from the desired location.

Click on the Edit menu and select the Copy option.

The image will be copied to the clipboard.

Move to the location where you wish to paste the copied image from the clipboard.

Click on the Edit menu and select the Paste option.

The steps to draw a rectangular box in the document are as follows:

Step 3:

Move to the location in the document where you wish to draw a rectangular.
Select the Rectangle tool from the Drawing toolbar.
The mouse pointer changes to a thin plus sign.

Drag and then release the mouse button to create a rectangular shape of
an appropriate size.

The mouse pointer is still with a thin plus sign which means you can draw
as many shapes as you want.

Two text wrapping options available in a word processing software:

+ Before: The text is placed before the image.

» After: The text is placed after the image.

The steps to give a watermark effect to an image are as follows:

Step 1:

Step 2:
Step 3:

Select the image in the document on which you want to apply Image Mode
tool. The Image toolbar appears.

Click on the Image Mode tool. A drop-down menu appears.
Select the Watermark option.

The watermark effect is applied to the image.

The steps to group different objects created in a document:

Step 1:
Step 2:

Select multiple objects by using mouse click and holding the Shift key.
Click on the Format — Group option and then select the Group option
from the sub menu.

OR

Right-click on the selected objects and then select the Group option from
the context menu.
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OR
Select the Group option from the Drawing Object Properties toolbar.
The selected objects get grouped into one object.

an index page in LibreOffice Writer, ABC Publisher can use the Table of Contents

feature. TO do this, follow the given steps:

Step 1:
Step 2:

Step 3:

Step 4:

Step 5:

b. Both

0 N o wuw

Move to the place in a document where you wish to insert a table of contents.

Select the Insert — Table of Contents and Index — Table of Contents, Index
or Bibliography option from the Menu bar.

The Table of Contents, Index and Bibliography dialog box opens.

When you select the Preview check box, the Preview Pane appears at the right
of the dialog box, which displays the preview of the table of contents.

Apply the different settings in the different options in the Table of Contents,
Index and Bibliography dialog box opens.

Click on the OK button.

c.  Alistrue but R is false.

A and R are true but R is not the correct explanation of A.

a. Statement 1 is TRUE, Statement 2 is TRUE.
c. Statement 1 is TRUE, Statement 2 is FALSE.

2. Electronic Spreadsheet (Advanced)

Do It Yourself
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Exercise {=s!

8 Unsolved

Section A: (Objective Type Questions)

A. 1L b 2. ¢ 3. ¢ 4,
7. ¢ 8. b 9. a 10.

B. 1. .ods 2. name 3.1 4,
6. Absolute Hyperlink 7. Cell Reference

C. 1 False 2. True 3. False 4,
7

. True

b

a

True

5. ¢ 6. d

5. Internet

8. Deleted

5. True 6. True

Section B: (Subjective Type Questions)

A. 1. You can rename a sheet by performing the following steps:
Step 1: Double-click the sheet in the Sheet tab.

OR

Right-click on the sheet in the Sheet tab and select the Rename Sheet option
from the context menu.

OR

Select the sheet in the Sheet tab and then select the Sheet Rename Sheet option
from the Menu bar.

The Rename dialog box opens.

Step 2:  Delete the old name and type a new name of your choice in the Name text box.

Step 3:  Click on OK button.

2. Relative Hyperlink: It refers to reaching the linked document with respect to the current
location. It will include the partial cell address in hyperlink. If the start and target locations
change relative to each other, then relative hyperlink will not work.

Absolute Hyperlink

It refers to reaching to the linked file by writing the complete address starting from the root
directory. If the target location is changed then the absolute hyperlink will stop working.

3. The steps to show comment in a spreadsheet are:

Step 1:  Select the cell containing comment that you want to show.

Step 2:  Right-click on the selected cell and select the Show Comment option from the

context menu.

The comment is displayed in the spreadsheet.
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The steps to hide comment in a spreadsheet are:

Step 1:
Step 2:

Select the cell containing comment that you want to hide.

Right-click on the selected cell and select the Hide Comment option from the
context menu.

The comment is hidden in the spreadsheet.

4. The steps to enable Macro recoding feature are as follows:

Step 1:

Step 2:

Step 3:

Step 4:
Step 5:

Select the Tools Options option in the Menu bar.
The Options dialog box opens.

Click on the LibreOffice category. The LibreOffice Base category expands and
displays the options.

Select the Advanced option. The options related to advance features of LibreOffice
displays on the right-side of the Options dialog box.

Select the Enable macro recording (may be limited) check box.
Click the OK button.

5. The steps to compare spreadsheets are as follows:

Step 1:
Step 2:
Step 3:

Step 4:

Step 5:

Open edited spreadsheet.

Select the Edit Track Changes option from the Menu bar.
Select the Compare Document option from the submenu.
The Compare to Original Document dialog box appears.
Select the original spreadsheet and click on Open button.

The Manage Changes dialog box opens with the changes after comparing the
document.

Accept or reject the changes and click on Close button.

6. To record a macro in LibreOffice Writer, you need to first enable the Macro Recording
feature and then click on the Tools Macros — Record Macro option.

1. There may be different issues with the shared document whenever you wish to save them:

 If it has not been modified and saved by another user since you opened it, it is saved
as usual.

« If the spreadsheet has been modified and saved by another user since you opened it,
one of the following will occur:

o If the changes made by others do not conflict with the changes made by you then
the document is saved and the message “Your spreadsheet has been updated with
changes saved by other users” appears, and any cells modified by the other user
are shown with a red border.

o Ifthe changes conflict, the Resolve Conflicts dialog will appear. You must decide for
each conflict which version to keep, yours or the other person’s. When all conflicts
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are resolved, the document is saved. While you are resolving the conflicts, no other
user can save the shared document.

No two or more users can save the same shared document at the same time. If the

other user is trying to save the same shared document. Then you will not have the
permission to save it. The document will be locked with the message merge-in in
progress. You have to cancel the save command and retry later.

When you successfully save a shared spreadsheet, the document shows the latest version
of all changes saved by all users.

The steps to record a macro are as follows:

Step L:
Step 2:
Step 3:

Step 4:

Step 5:

Step 6:

Step 7:

Create a new spreadsheet.

Select the Tools Macros option from the Menu bar.
Select the Record Macro option from the submenu.
The recording will start immediately.

Add the names of five cities, format the list with different font colours, cell
background colour.

After you are done with the steps for recording macro, click on the Stop Recording
button.

The Basic Macros dialog window opens.
Click on (+) sign in front of My Macros — Standard — Modules1.

The name of the macro by default is Main and is saved in the Standard Library in
Modulel. You can change the name of the macro in the Macro Name textbox.

Click on Save button.

The macro is saved.

The steps to run a macro are as follows:

Step 1:

Step 2:
Step 3:

Step 4:

Step 5:
Step 6:

Create a new spreadsheet or open an existing spreadsheet where you want to
run a macro.

Select the Tools Macros option from the Menu bar.
Select the Run Macro option from the submenu.
The Macro Selector dialog box opens.

Open the folders by clicking on (+) sign in front of My Macros — Standard —
Modulel. The list of macros within it will be displayed.

Select the macro.

Click on the Run button, as shown in below figure:

The macro runs in the spreadsheet.

Follow the given steps to link data from an external source:

Step 1:

Select the cell where you want to insert data from external source.
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Step 2:  Select the Sheet — External link option from the Menu bar.
The External Data dialog box opens.

Step 3:  Type the path of the external data source in the URL of External Data Source
text box or click on the Browse button to select the file.

The Insert dialog box opens.
Step 4:  Navigate the location and select the file. Then, click on the Open button.

The path of the external source is displayed in the URL of External Data Source
text box.

Step 5:  Select the named ranges or tables you want to insert.

Step 6:  Select the Update every check box to specify the time by which the selected
ranges or tables are updated automatically.

Step 7:  Click on OK button.
The external data is linked to the sheet.

Whenever a macro is created the code generated equivalent to the instructions given in a
recorded macro are stored internally in LibreOffice Calc in a programming language called
BASIC. It is also possible to view and thus edit the code of a macro, if you have knowledge
of BASIC. You can view the code generated for the macros by following the given step:

Step 1:  Select the Tools Macros option from the Menu bar.
Step 2:  Select the Organise Macros Edit Macros option from the submenu.
This will open a code window as shown below:

You will see that the code begins with sub followed by a macro name and ends with End
Sub.

The steps to create a simple macro function are as follows:

Step 1:  Create a new spreadsheet.

Step 2:  Select the Tools Macros option from the Menu bar.

Step 3:  Select the Organise Macros Edit Macros option from the submenu.
The Macro code window opens.

Step 4:  Create an empty line after Sub main and End Sub. Write the given code:
Function Displaycontent ()
Displaycontent ()="Macros are interesting”
End Function
The code window after the given code is entered.

Step 5:  Press Ctrl+S or click on Save button on the Standard toolbar to save the changes
in the code window.

Step 6:  Close the code window.
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Step 7:  Now, when we type =Displaycontent() in any cell in the sheet.

Then, you will see the text Macros are interesting displayed automatically in a cell as
shown below:

Follow the following steps to format the comment.
Step 1:  Right click on the cell where the comment is added.
Step 2:  Select the option "Format cell”, which will display the Format Cells dialogue box.

Step 3:  You can apply the various formatting features from its tab such as Font, font
Effects, Alignment, Borders, Background and Cell Protection. Change the font,
text colour, fill colour, line colour for the comment box as desired and click on
OK button to apply the changes.

Observe the desired formatting features applied to the comment box.

Data analysis plays a pivotal role in modern organisations for numerous reasons. Data
analysis helps organisations in various tasks such as informed decision-making, problem-
solving, understanding customer behaviour, improving efficiency, performance evaluation,
and risk management. It is required to study the trends of products required in the local
and global market. It is an important part of many organisations for planning and taking
important decisions for the progress of the company.

The LibreOffice Calc offers several built-in tools for data analysis, which are essential for
performing various analytical tasks directly within the spreadsheet software. These tools
include Data Consolidation, What-if Analysis, Goal Seek, solver and many more.

The best tool for Amit to combine and find the average of marks obtained by his five friends
in the previous three periodic tests is Data Consolidation.

The steps to use it:
Step 1:  Click on the Data menu.
Step 2:  Select the Consolidate option.

The appropriate what-if analysis tool for Rohit to calculate the score in IT to achieve 80
percent in aggregate is Goal Seek.

The steps to use it:
Step 1:  Click on the Tools menu.
Step 2:  Select the Goal Seek option.

Krish and Kritika should use Sharing a Spreadsheet feature to access and work on the
same spreadsheet simultaneously. This allows multiple users to collaborate on the same
document in real-time, making it ideal for projects like their survey.

The steps to use the share a spreadsheet feature:
Step 1:  Click on the Tools menu.

Step 2:  Select the Share Spreadsheet option.
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4. The what-if analysis tool that Rohan can use in LibreOffice Writer to find the money, he
can now afford to spend is Goal Seek.

The steps to use it:
Step 1:  Click on the Tools menu.
Step 2:  Select the Goal Seek option.
5. a. Track Changes is the feature Raj should use to see the changes made by his employees.
b. The steps to use the Track Change feature are as follows:
Step 1:  Click on the Edit menu.
Step 2:  Select the Track Change option.
c.  The steps to add comment to the changes made are:
Step 1:  Select the changes cell in the reviewed spreadsheet.
Step 2:  Select the Edit — Track Changes option from the Menu bar.
Step 3:  Select the Comment option from the submenu.
The dialog box opens with automatically-added change.
Step 4:  Type your own comment in the Text text box.
Step 5:  Click on the OK button.
d. To accept or reject changes in a spreadsheet, perform the following steps:
Step 1.  Open the reviewed spreadsheet.
Step 2:  Select the Edit Track Changes option from the Menu bar.
Step 3:  Select the Manage option from the submenu.
The Manage Changes dialog box opens.

Step 4:  Click the Accept or Reject button to accept or reject the selected changes
made, respectively.

Step 5:  Click the Accept All or Reject All button to accept or reject all the changes
made, respectively.

Step 6:  Click the Close button to close the Manage Changes dialog box dialog box.
6. a. Toinserta sheet, perform the following steps:
Step 1:  Select a sheet where you want the sheet to be inserted after it or before it.
Step 2:  Click on Sheet Menu and select Insert Sheet option from the Menu bar.
OR

Right-click on the empty area in the Sheet tab and select Insert Sheet option
from the context menu.

OR
Click the Add new sheet button in the Sheet tab.
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Step 3:
Step 4:

The Insert Sheet dialog box opens.
Specify the details in the dialog box
Click the OK button.

You can rename a sheet by performing the following steps:

Step 1:

Step 2:

Step 3:

Double-click the sheet in the Sheet tab.
OR

Right-click on the sheet in the Sheet tab and select the Rename Sheet
option from the context menu.

OR

Select the sheet in the Sheet tab and then select the Sheet Rename Sheet
option from the Menu bar.

The Rename dialog box opens.

Delete the old name and type a new name of your choice in the Name text
box.

Click on OK button.

Follow the given steps to delete a spreadsheet:

Step 1:

Step 2:

Right-click the sheet on the Sheet tab and select the Delete Sheet option
from the content menu.

OR

Select the sheet in the Sheet tab and then select the Sheet Delete Sheet
option from the Menu bar.

The Confirmation message box appears.

Click the Yes button to confirm the deletion of sheet.

To create a hyperlink, follow the given steps:

Step 1:

Step 2:

Step 3:
Step 4:

Select the cell in a spreadsheet in which you want to create hyperlink. If there
is already some text, then select the text.

Click on Hyperlink icon on the Standard toolbar.

OR

Select the Insert Hyperlink option from the Menu bar.
The Hyperlink dialog box will open.

Select the Internet option

Enter the URL (web address) of the website or webpage you want to link to
in the URL text box.

Step 5: Type the text you wish to make as hyperlink in the Text text box.

Step 6:

Click on the OK button.
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7. b. Both A and R are true but R is not the correct explanation of A
8. a. Both Aand R are true and R is the correct explanation of A
9. d. Statement 1l is FALSE, Statement 2 is TRUE

3. Database Management System

T hpage-191

T hpage-229

Do It Yourself
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Exercise {=s!

A. 1
7.
B. 1L
7.
C. L
7.
D. 1
A. 1
2.
3.
4.

8 Unsolved

Section A: (Objective Type Questions)

d 2. ¢ 3. ¢ 4. a 5. a 6. a

b 8. d 9. ¢ 10. a

Forms 2. Primary 3. Query 4. Alternate 5. Record 6. Candidate
Data type 8. Table Data View 9. Image 10. Sorting
True 2. True 3. True 4. True 5. True 6. True
True 8. True 9. True 10. True

d 2. b 3. a 4. e 5 ¢

Section B: (Subjective Type Questions)
Entry Required
The field with Entry Required as “Yes” means that the field cannot be left blank. The user
needs to enter data in this field. It contains a drop-down “Yes"/ “No". The default value
for this property is “NO" which means the field if left blank will contain a NULL (nothing)
value.
Default Value

It's the value that can be assigned to the field, by default. This value gets automatically added
in a field at the time of adding a record in a table. The user, if wants can make a change in
it.

Data Redundancy means keeping multiple copies of the same data in a system.

Referential Integrity is a fundamental rule in relational databases that ensures the consistency

and validity of relationships between tables. It deals with the rule that values of foreign

key in one table is derived from the values of primary key in another table to ensure that

this relationship between two tables will provide accurate and consistent data.

Referential Integrity helps in the following conditions:

« Whenever a new record is added in a table with the foreign key then it ensures that the
value added should exist in a primary key of the other linked table.

« Update or deletion in the Table with the primary key is not allowed if the matching
record exists in the foreign key of the other table.

A report displays the retrieved data in an appealing and customised format. Reports can
be created from a table, a query, or both. Ideally, if a report needs to be generated from
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10.

multiple tables, it is recommended to first create a query and then use that query to generate
the report.

A data model in database management systems (DBMS) is a conceptual representation
of how data is organised and structured within the database. It defines the relationships
between different types of data, the constraints that apply to the data, and the operations
that can be performed on the data.

Memo data type stores up to the max length or number indicated by user. It is used to store
some descriptive data having more than 255 characters. Memo data type allows to store
text data up to 64000 characters. For example: Medical description of a patient, Student
achievement details in student table.

Query is a set of commands that retrieve and display data from one or more tables in a
database. This is done by giving specific search criteria to the DBMS so that we can view
the exact information that we want.

To create a table, select the Table option in the Database pane. In the LibreOffice Base,
there are two methods that are used to create a table. These methods are as follows:

« Create Table in Design View
« Use Wizard to Create Table

The significance of default values in a database field is that they provide a pre-determined
value that will be automatically entered into the field for new records unless the user
manually changes it.

Design View allows you to manually specify the structure of your table by defining its fields,
data types, and properties. While, the datasheet view is used to enter data in a table.

Some advantages of the database are as follows:

- Organised storage: Databases employ structured formats and indexing mechanisms
to organise data efficiently, which allows fast and accurate retrieval of information.
This organisation typically follows a predefined schema, ensuring data integrity and
facilitating query operations.

- Data analysis: DBMS systems provide powerful querying capabilities that enable users
to perform various analyses on the stored data. Aggregate functions, sorting, filtering,
and grouping operations make it easy to understand such as maximum, minimum,
average, or other statistical measures from the data.

* Reduces data redundancy: Data Redundancy means keeping multiple copies of the
same data in a System. Using DBMS, the data in tables are interlinked through a common
column to avoid duplicate entries. Data constraints are applied to store data based on
different criteria.

« Sharing of data: It means data can be accessed by multiple users at the same time.
Different users can have different rights and privileges to access data. Some may have
the right to only view the data. Some may have permission to modify the data. Database
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administrators manage the rights and privileges for sharing data through a centralised
system.

There are three important types of relationship that can be created in a database which
are as follows:

One-to-One: In this type “One record of Master table is related to only one record of
Transaction Table". It is represented as a 1:1 relationship.

One-to-Many: This is one of the most common types of relationship between the tables
in a database. In this type “Each record of Master table is related to multiple Records
of Transaction table.” It is represented as a 1:n relationship.

Many to Many: In this relationship, “Multiple records of Master table is related to
multiple records of Transaction table”. Generally, this type of relationship is set when
certain records must be saved more than once in both the related tables. It is represented
as a n:n relationship.

To create a table, select the Table option in the Database pane. In the LibreOffice Base,
there are two methods that are used to create a table. These methods are as follows:

Creating a Table in Design View: Design View allows you to manually specify the
structure of your table by defining its fields, data types, and properties. You have
complete control over the table’s layout and can directly define attributes such as field
names, data types (e.g., text, number, date/time), field sizes, and validation rules like
creating tables using Design View gives us more flexibility.

Use Wizard to Create Table: A wizard is a step-by-step process of doing a specific task
through a set of dialog boxes. Creating tables using wizards offers a convenient and
efficient approach to database design, particularly for users who are less experienced
or who need to quickly prototype database structures. On the other hand, for some
users creating the table using wizard restricts to use the same fields in the pre-designed
tables. It may not solve the purpose in real scenario, as it will create a table with the
different columns that are not matching with the user’s column choice.

Sorting means rearrangement of the data either in the ascending order (smaller value to
bigger value) or in the descending order (bigger value to smaller value). The records will
be rearranged with respect to the sorted field.

The steps to sort the table are as follows:
Step 1:  Select the table.

The table opens in the Table Data View window.

Step 2:  Click on the column header based on which you want sort the data.

Step 3:  Click on the Sort Ascending button to sort data in ascending order. All the

records will be rearranged in the ascending order.
OR
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Click on the Sort Descending button to sort data in descending order. All the
records will be rearranged in the descending order

The Sort Ascending and Sort Descending button sorts the data by one criterion only.
LibreOffice Base allows you to combine several criteria by selecting Sorticon on the toolbar.
The Sort Order dialog can be used to do the required changes, perform the following step
for the same:

Step 1:  Click on the Sort icon on the toolbar.

The Sort Order dialog box opens, as shown below:
Step 2:  Select the Field name and Order from the drop-down list.
Step 3:  Click on the OK button.

To open an existing table in a database in LibreOffice Base, you can use the following two
methods:

Method 1: Using double-click
Step 1:  Open the LibreOffice Base application and load the database file.
Step 2:  Click on the Tables option in the Database pane.
Step 3:  Double-click on the table in the Table pane
This will open the table in Table Data View.
Method 2: Using the context menu
Step 1:  Open the LibreOffice Base application and load the database file.
Step 2:  Click on the Tables option in the Database pane.
Step 3:  Right-click on the table in the Table pane
A context menu appears.
Step 4:  Select the Open option from the context menu
This will open the table in Table Data View.
Forms

A form is a feature of a database using which we can enter data in a table in an easy and
user-friendly manner. They provide a user-friendly way to facilitate the input, editing, and
viewing of data within an RDBMS with the help of graphical elements such as text boxes,
drop-down menus, checkboxes, and buttons.

Reports

Reports are formatted presentations of data generated from a database. They take raw
data and turn it into a structured, easy-to-understand format. The output of a query may
be displayed in the form of reports with data arranged in the form of rows and columns.
But if we want the report to be formal and in proper layout, then we can use the Reports
feature of RDBMS.
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The Forms Control toolbar contains various controls that can be added to the form. The
Forms Control toolbar appears on the left of the Database Form window.

Some functions of the Form Controls toolbar are as follows:

Select Tool: Allows you to select and manipulate existing controls on the form.

Label Field: Adds a text label that is not connected to a database field. Labels are used
to provide descriptive text or instructions on a form.

Text Box: Inserts a field that allows the user to enter or display text. This control can
be bound to a database field to display or accept user input.

List Box: Creates a drop-down list that allows the user to select an option from a list of
values. The list can be static or dynamically generated from a database table or query.

Combo Box: Inserts a combination of a text box and a drop-down list. The user can
either enter a value directly or select from a list of predefined options.

Check Box: Adds a box that can be checked or unchecked by the user, representing a
boolean (true/false) value.

Radio Button: Inserts a button that allows the user to select one option from a set of
mutually exclusive choices.

Two important types of relationship are:

One-to-Many: This is one of the most common types of relationship between the tables
in a database. In this type “Each record of Master table is related to multiple Records
of Transaction table.” It is represented as a 1:n relationship.

Many to Many: In this relationship, “Multiple records of Master table is related to
multiple records of Transaction table”. Generally, this type of relationship is set when
certain records must be saved more than once in both the related tables. It is represented
as a n:n relationship.

The suggested database objects Ananya should use in her bookshop's database for each
of her tasks:

a.
b.

Q 0

To store the information of the total stock in tabular form: Table

To design an interactive screen to enter and display the information: Form

To create a report of stock available in her bookshop: Report

To create a query based on a criterion: Query

Two Different Ways of Creating a Form in a Table:

» Use Wizard to Create Form

« Create Form in Design View

Steps to create a relationship between tables are as follows:

Step 1.  Select the Tools — Relationships option from the Menu bar.

The Relation Design window opens with the Add Tables dialog box.
Information Technology 402-X (Answer Key) 2 ;9 :
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Step 2:
Step 3:

Step 4:
Step 5:

Select the table that you want to add in the relationship as Subject.
Click the Add button in the Add Tables dialog box.

Similarly, you can add more tables. In this case, we have added the Teacher
table.

Click the Close button in the Add Tables dialog box.

Click on Subject Code in Subject table and drag it to the Subject Code in
Teacher table. Release the button to see a relationship between tables.

Reports are formatted presentations of data generated from a database. They take
raw data and turn it into a structured, easy-to-understand format. The output of a
query may be displayed in the form of reports with data arranged in the form of rows
and columns. But if we want the report to be formal and in proper layout, then we
can use the Reports feature of RDBMS.

The Use Wizard to Create Report option

Both A and R are true but R is not the correct explanation of A.

Both A and R are true and R is the correct explanation of A.
Statement 1 is TRUE, Statement 2 is FALSE.
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